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Abstract 

Nowadays, the construction industry is rapidly expanding, and the complexity of con-
struction projects necessitates improved collaboration among the various professionals 
involved in this industry. In complex and huge projects such as that infrastructures, 
there are a huge amount of data usually with different formats. This makes the acces-
sibility of required data time-consuming and costly. therefore, there is a need to adopt 
new systems and technologies to manage information more efficiently. Thanks to the 
application of BIM, the organization of data can be obtained and data sharing between 
different figures improves. BIM also helps in the optimization of MEP design by iden-
tifying interferences in the early stages of the design, reducing errors and thus speeding 
up the delivery time and saving costs.  

The following thesis deals with generating an information model of the Fire Protection 
System for an underground railway station. The main objective of the thesis is to try to 
export the data from the Revit model into JSON Format to make it available for mid-
dleware or any kind of platform for facility management. The paper is divided into 
different parts that follow the consecutive order of development of the thesis. Starting 
from the introduction and the first part dedicated to knowledge of BIM methodology, 
general notions, and the role of BIM in the management and maintenance of the infra-
structures. The central part will focus on developing the model and families. The next 
part is about verifying and validating the model in terms of the Clash Detection by 
Navisworks software and modifying the model based on the clashes found in the test 
to make sure that there are no conflicts between the model of fire protection system 
and the other model includes HVAC system which is done by the other colleague in 
her thesis. Finally, the last part will focus on exporting the model and data from the 
Revit to the JSON language by using Dynamo.  

 



1 | P a g e  

 

 

Contents 

Introduction ……………………………………………………………… 7 

1. The BIM Methodology ………………………………....…................  8 

1.1.   BIM concept ……………………………………………………...  9 

1.2.   Interoperability …………………………………………………... 11 

1.3.   The Standardization System in the World …………………......... 14  

1.4.  Legal Context ……………………………………………………. 15 

1.4.1.  UNI EN ISO 19650 ..............................................................   15 

1.4.2.  Ministerial decree number 560/2017 ………........................   15 

1.4.3.  Ministerial decree number 560/2017 ……………………....   16 

1.4.4.  The UNI 11337 Standard ………………………….............    17 

1.5.   LOD ……………………………………………………………... 17 

1.6.   Common Data Environment (CDE) ……………………………..  22 

1.7.   Roles and Responsibilities.…………………….……...................  25 

1.8.  BIM for Operation and Management of Infrastructure…………...  27 

2. Case Study ……………..……..…………………................................  28 

2.1.   Metro Station …………………………………………………….  29 

2.2.   MEP Engineering ………………………………………………..  30 

2.3.   Methodological Approach ………………………………………  31 

3. Information Modeling ……………….………………………………  32 

3.1.   Data Collection ………………………………………… 33 
3.2.   Software ………………………………………………………… 34 

3.3.   Setting Phases – Template ……………………………………… 35 

3.3.1. User Interface and Display …………………………………   35 

3.3.2. Revit Links …………………………………………………   36 

3.3.3. Shared Coordinates …………………………………….......   37 

3.3.4. Levels 38 



2 | P a g e  
 

3.3.5. Work-Set …………………………………………………...   38 

3.3.6. Revit Families ……………………………………………..    39 

3.3.7. Parameters ………………………………………………….   42 

3.4.   Modeling ………………………………………………………... 45 

3.4.1. Fire Protection System ……………………………………..   45 

3.4.2. Routing Preferences …………………………………….....    46 

3.4.3. Materials and colors ………………………………………..   50 

3.4.4. Pipe Accessories …………………………………………..     50  

3.4.5. Sprinklers …………………………………………………..    51 

3.4.6. Result ……………………………………………………...     52 

3.5.   Federated Model ………………………………………………. 53 

4.   Information Delivering …………………………………………… 56  

4.1.  Interference Check ……………………………………………… 57 

4.1.1. Data Collection …………………………………………….    57 

4.1.2. Software ……………………………………………………    59 

4.1.3. Import of Disciplinary Models …………………………….    59 

4.1.4. Check for Duplicates – Level 1 Validation ………………..    60 

4.1.5. Hard Clash Detection – Level 2 Validation …………….….   61 

4.1.6. Clashes statuses …………………………………………….   64 

4.1.7. Result ……………………………………………………….   65 

4.2.   Exporting Process ………………………………………………. 66 

4.2.1. Dynamo …………………………………………………….   66 

4.2.2. Dynamo for Exporting Data ………………………………..   67 

4.3.   JSON Format …………………………………………………… 71 

4.3.1. Results ………………………………………………………  75 

5. Conclusion …………………………………………………………… 76 

 

 
 



3 | P a g e  
 

Table of Figures  
 

1. Benefits of BIM process ………………………………………....  9 

2. BIM Dimensions ………………………………………………...  10 

3. Interoperability of BIM ………………………………………….  11 

4. Different levels of BIM interoperability …………………………  12 

5. Application diagram of the Standards in the world ……………... 14 

6. LOD, AIA ………………………………………………………..  19 

7. Data flow in the digital process through the LODs of the objects . 20 

8. UNI 1137-4, Example of LOD prefabricated walls ……………...  21 

9. Graphics bases on ISO 19650-1 presenting Information progress  

during different delivery phases …………………………………….. 24 

10.   Different figure involves in a BIM Process …………………….  26 

11.   Lifecycle Phases ………………...…………….…........................ 27 

12.   Three-dimensional model of the Fire Protecting system .............  29 

13.   Project Workflow ………………………………………….........  31 

14.   Autodesk Docs platform ………………………………….…….  33 

15.   Project Browser, Revit ………………………………………….  36 

16.   Link Revit, Revit …………………………………….………….  36 

17.   Import/Link RVT, Revit dialog .................………………….......  37 

18.   Manage Links, Revit …………………........................................  37 

19.   Shared Coordinates, Revit …………………………………...….  38 

20.   Work-set, Revit …………………………………….…………...  39 

21.   Load Family, Revit ……………………………………………...  40  

22.   New Family – Select Template file, Revit ………………………   41 

23.   Family Types, Revit ……………………………………………..  43 

24.   Parameter Properties, Revit ……………………………………...  44 

25.   Project Parameters, Parameter Properties, Revit ………………... 44 

26.   Import PDF, Revit ………………………………………….…... 45 



4 | P a g e  
 

27.   System Families – Pipe, Revit …………………………………. 45 

28.   Pipe Properties Window, Revit ....................................................  46 

29.   Routing Preferences, Revit ……………………….......................  47 

30.   Pipe Fitting Families, Revit ……………………………………..  47 

31.   Elbow Fitting Family, Revit …………………………………….   48 

32.   Mechanical Settings, Revit …………………………………..….  48 

33.   Analyze – Show disconnect, Revit …………………………..….  49 

34.   Show Disconnects Option – Pipe, Revit ………………………...  49 

35.   Material Browser, Revit ………………………………………....  50 

36.   Project Browser, Revit …………………………………………..  50 

37.   Pipe Accessories, Revit ………………………………………….  51 

38.   Sprinklers, Revit ………………………………………………...  51 

39.   Top View of the Model, Revit …………………………………..  52 

40.   Front View of the Model, Revit ………………………………....  52 

41.   isometric View of the Model, Revit ……………………………..  53 

42.   Federated Model – Section T2-T2, Revit ………………………..  54 

43.   Section T2-T2 from the plan, Revit ……………………………...  54 

44.   Federated Model - Isometric View, Revit ……………………….  55 

45.   Export NWC Format, Revit ……………………………………... 57 

46.   Export NWC Format, Revit ……………………………………... 58 

47.   Navisworks Option Editor - Export NWC, Revit ……………….. 58 

48.   Append NWC, Navisworks ……………………………………... 59 

49.   Add Duplicate Test, Navisworks ………………………………... 60 

50.   Duplicate Check Setting, Navisworks …………………………... 60 

51.   Duplicate Check Results, Navisworks …………………………... 61 

52.   Hard clash detection Check Setting, Navisworks ……………….. 61 

53.   Clash Detection Results, clash1 – PFP vs M, Navisworks ……… 62 

54.   : Clash Detection Results, clash7 – PFP vs M, Navisworks …….. 62 

55.   Interference Report, Navisworks ………………………………... 63 



5 | P a g e  
 

56.   Add Comments, Navisworks ……………………………………. 63 

57.   Comment Example – PFP vs Ventilation, Navisworks …………. 64  

58.   Clashes Status, Navisworks ……………………………………... 64 

59.   Clash Detection Result Test, Navisworks ………………………. 65 

60.   Anatomy of a Node, Dynamo …………………………………… 66 

61.   Selecting all Elements of the Revit Pipe Category, Dynamo ….... 67 

62.   Pipe Category Parameters, Dynamo …………………………….. 67 

63.   Creating New Project Parameters, Revit ………………………... 68 

64.   Element Properties – Data, Revit ……………………………….. 69 

65.   Parameter Groups, Dynamo …………………………………….. 69 

66.   Parameter Groups, Dynamo …………………………………….. 70 

67.   Dynamo Workflow, Dynamo …………………………………… 70 

68.   Dynamo Packages, Dynamo ……………………………………. 71 

69.   Dynamo online search package for JSON, Dynamo ……………. 71 

70.   JSON Package, Dynamo ………………………………………... 72 

71.   Dynamo workflow – Exporting to JSON Format, Dynamo …….. 72 

72.   Write to JSON file, Dynamo ……………………………………. 73 

73.   JSON File path, Dynamo ………………………………………... 73 

74.   Dynamo Workflow Run, Dynamo ………………………………. 74 

75.   JSON File ……………………………………………................... 75 

    

 

  



6 | P a g e  
 

List of Tables 
 

1. File codification …………………………………………………....  34 
2. Family Codification ………………………………………………... 42 

  



7 | P a g e  
 

Introduction 

Building Information Modeling (BIM) is a growing trend in the Architecture, Engi-
neering, Construction, and Operations (AECO) industry which guarantees to facilitate 
the integration, interoperability, and collaboration in the future of the building sector. 
It begins to make its way in the early 2000s in the United States [1]. Building Infor-
mation Modelling (BIM), as defined by the U.S. National Building Information Model 
Standard Project Committee, “is a digital representation of physical and functional 
characteristics of a facility. A BIM is a shared knowledge resource for information 
about a facility forming a reliable basis for decisions during its life cycle; defined as 
existing from earliest conception to demolition” [2]. A BIM system is a centralized 
system for managing various types of information, such as Enterprise Resource Plan-
ning, resource analysis software packages, technical reports, and so on. The main fea-
ture of a BIM, however, is its 3D modeling system with data management, data sharing, 
and exchange throughout the building's life cycle. A building is, in fact, made up of 
geometric elements that serve as the foundation for its design. Furthermore, parametric 
modeling offers powerful mechanisms for automating the generation of building infor-
mation. Knowing the object behavior, these mechanisms would ease the maintenance 
and validity of building designs. The model at the heart of the BIM approach is a com-
mon and calculable 3D model of the building, which aids in overcoming the shortcom-
ings of a paper-based 2D approach. As a result, BIM is a methodology that facilitates 
multidisciplinary collaboration and information management among project stakehold-
ers [3]. BIM was initially intended to be used for the building sector, but it is now being 
used in areas of construction that it was not intended for, such as civil infrastructure. It 
is thought that the use of BIM in infrastructure is nearly three years behind its use in 
buildings, but the use of BIM in infrastructure has recently increased. BIM can assist 
in various design phases such as the planning phase, detailed design, and design opti-
mization. It improves design quality, provides a better visual representation of the in-
frastructure, and fosters collaboration. One of the most favored benefits of using BIM 
in infrastructure from the design stage is the reduction of omissions and errors, as well 
as the subsequent reduction of conflicts and coordination problems on the construction 
site [4]. The thesis is based on BIM and consist of the practical application of this 
methodology on a fire protection system of an underground railway station and focus-
ing on exporting the data from the model in a format that can be used for the integration 
between Building Information Model (BIM) and Building Management Systems 
(BMS). 
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1.1.   BIM Concept 

BIM is an acronym for Building Information Modeling or Building Information 
Management. Building Information Modeling (BIM) is the foundation of digital 
transformation in the architecture, engineering, and construction (AEC) industry which 
is becoming increasingly popular around the world. Building Information Modeling is 
the holistic process of creating and managing information for a built asset. Based on 
an intelligent model and enabled by a cloud platform, BIM integrates structured, multi-
disciplinary data to produce a digital representation of an asset across its lifecycle, from 
planning and design to construction and operation  [5]. In recent years, the proliferation 
of BIM has offered designers and builders new opportunities to construct better quality 
buildings at lower cost and with a shorter project lifespan. Building sectors such as the 
architectural sector, the engineering sector, and the construction sector each have 
defined goals and unique advantages of BIM. For example, in the construction 
industry, BIM helps reduce building material waste and also virtually assesses project 
risk. Most importantly, BIM helps detect where clashes are occurring and also ensures 
a reduction in on-site errors, etc. Perhaps the main overall benefit of the BIM process 
is that it supports the construction process and the design process from scratch to the 
whole package and beyond for all parties involved. BIM has revolutionized the 
construction industry by allowing anyone authorized, from anywhere in the world, to 
access building information and to communicate and collaborate with people on-site. 
Having said that, it is therefore important that the builders, designers, and project 
sponsors fully understand the BIM models, the BIM software, and its components. [6]. 

 
 

Figure 1: Benefits of BIM process 
Source: https://outsourcestructuraldrafting.weebly.com/blog/how-bim-process-is-

useful-in-construction 
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The necessity to distinguish between modeling geometry in two and three dimensions 
led to the development of BIM dimensions. This has been part of the modeling 
evolution, moving from drawing boards to the first 2D CAD systems to 3D modeling 
packages [7]. BIM is not limited to the three-dimensional model of the building but 
also can be used for a pre-defined specific purpose which is called as-use cases. 
Depending on the complexity of the project and its requirements specific parameters 
can be added to the existing information known as BIM dimensions. these dimensions 
help better understand the construction project by enhancing the data associated with 
the model. Each of the BIM dimensions– 3D, 4D, 5D, 6D & 7D has its purpose and 
helps to understand the project cost, timeline, and sustainability. [8]. 
 
The UNI 11337 standards, the voluntary technical standards adopted in the Italian 
context on the digital management of construction process, report the following 
classification: 
 

 

Figure 2: BIM Dimensions 
Source: https://biblus.acca.it/focus/le-7-dimensioni-del-bim/ 

 
 3D - Three-dimensional modeling: Provides a three-dimensional model of the 

project that can be used through the whole lifecycle of the building which helps 
to reduce the errors from design to construction and maintenance. 

 4D - Time management: This dimension is related to time management which 
reduces or cancels the possibilities of interferences in the entire life of the 
project. it results in optimization of the time management and coordination 
between different figures involved in the project. 

 
 5D - Economic management: the fifth “BIM-dimension” allows, through the 3D 

model and the 4D BIM, to have full control of costs over time. This option 
enables the creation of efficient and convenient constructions. 
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 6D - Life cycle and maintenance: It allows optimization of the management and 
maintenance of the building object throughout its life cycle by providing 
information on the individual components from technical systems to finishes. 

 7D - sustainability: This dimension relates to analyzing the energy consumption 
of the building which helps in adopting better solutions for reducing energy 
consumption and ensuring the project's sustainability. 
 

1.2.   Interoperability 

Interoperability can be defined as the ability of one system to work with other systems 
without any effort on the part of the end user of the system, especially when exchanging 
information between the systems. Fully interoperable systems would not contain er-
rors, omissions, or data loss when the information is transferred from application to 
application [4]. BIM Interoperability is one of the pillars of Building Information Mod-
eling. The design and construction of a building involve various figures whom each 
operate within their own area of interest. BIM makes possible the collaboration be-
tween the different figures involved in the different phases of the life cycle of a struc-
ture, in order to insert, extract, update or modify information in BIM. 
 

 

Figure 3: Interoperability of BIM 
Source: https://www.archweb.com/en/blog/post/meaning-interoperability-BIM/ 
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There are different levels of BIM interoperability: 

 Interoperability between software from the same vendor: 
A good example of interoperability between software from the same vendor in 
the construction industry is a service engineer, architect and structural engineer 
all working on separate 3D models in their versions of Autodesk Revit. These 
separate models are aligned to show a combined design model and are moved to 
the construction team in order to plan the work in Autodesk Navisworks. This 
helps in avoiding clashes between structure and services during construction. 

 Interoperability between software from the different vendors: 

A building cannot be fully designed and built using software from a single 
software vendor. When software from various vendors needs to communicate, 
then communication rules need to be agreed. As far as construction is concerned, 
for example, a user can design the building in ArchiCAD and complete the 
specification using NBS Create. This level of interoperability can greatly 
minimize costly errors and help with coordinating project information. 

 Interoperability through open data standards: 

The final method of BIM interoperability considered here is where the 
information is to be displayed or transferred between software applications 
through open data standards. Within the construction industry, there exist a well-
established data standard for the transfer of data such as Green Building XML 
and Industry Classes. Open standards allow information and software from 
multiple sources to work together to improve the workflow in the construction 
industry. Standards also make data interchange in a secure way, without errors 
and/or loss of information [9], [10]. 

 

Figure 4: Different levels of BIM interoperability 
Source: https://www.revitmodelingindia.com/latest-blog/bim-interoperability/ 

 

 

https://www.revitmodelingindia.com/latest-blog/bim-interoperability/
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IFC Standard 

The IFC format is an open and non-proprietary format that complies with the 
international standard ISO 16739. Designed by building SMART International, 
it serves to ensure interoperability between the various figures operating in the AEC 
sector. The IFC file is in fact used for the exchange of information and the sharing of 
data during all phases of design, construction, management and maintenance. The 
format allows you to produce files that include: 

 IFC geometric information of the various entities of "simple" building 
components and all the data associated with them; 

 IFC alphanumeric information that specifies the parameters, physical properties 
and construction information of the entire work. 

All information belonging to the file is organized through classification systems that 
divide and distribute objects into categories and subcategories [11]. 

Open BIM 

openBIM extends the benefits of BIM (Building Information Modeling) by improving 
the accessibility, usability, management, and sustainability of digital data in the built 
asset industry. At its core, openBIM is a collaborative process that is vendor-neutral. 
openBIM processes can be defined as sharable project information that supports 
seamless collaboration for all project participants. openBIM facilitates interoperability 
to benefit projects and assets throughout their lifecycle. openBIM empowers 
stakeholders to develop new ways of working by transforming traditional peer-to-peer 
work processes. By breaking down data silos, openBIM can greatly improve project 
delivery and asset performance. Firms that adopt an openBIM approach develop cross-
party collaboration, enhanced communication, and industry-standard exchange 
methodologies. This delivers better project outcomes, greater predictability, improved 
performance, and increased safety with reduced risk. Throughout the whole lifecycle 
of an asset, openBIM helps connect people, processes, and data to achieve asset 
delivery, operation, and maintenance goals. openBIM plus seamless digital workflows 
make critical project information accessible to participants on a timely basis to support 
decision-making through various phases of the project from inception to hand-over to 
refurbishment and even demolition. openBIM removes the traditional problem of BIM 
data that is typically constrained by proprietary vendor data formats, by discipline, or 
by the phase of a project. By adhering to international standards and working 
procedures, openBIM extends the breadth and depth of the use of BIM by creating 
common alignment and language. Technical applications developed for openBIM 
improve the management of data and eliminate disconnected workflows. Independent 
quality benchmarks ensure reliable open data exchanges. openBIM permits digital 
workflows based on vendor-neutral formats such as IFC, BCF, COBie, CityGML, 
gbXML, etc. openBIM enables an accessible digital twin which provides the core 
foundation to a long-term data strategy for built assets. This provides better 

https://www.buildingsmart.org/
https://www.buildingsmart.org/
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sustainability for projects and more efficient management of the built environment 
[12]. 

1.3.   The Standardization System in the World 

With the release of ISO 19650 (parts 1 and 2) at the end of 2018, the new regulatory 
scenarios at the international, EU and individual state level are slowly being outlined.  

 The international standards, are developed and published by the ISO 
(International Organization for Standardization), can be adopted on a national 
level by each member state on a voluntary basis. In Italy they are recognizable 
by the UNI ISO acronyms; 

 The European standards, which are elaborated by the CEN (European 
Committee for Standardization) in the three recognized languages, English, 
French and German. Each member state is obliged to transpose them and 
withdraw the norms in force, typically national, in contrast with them. For 
example, they recognize themselves as UNI EN; 

 National standards are developed by the recognized national body. In Italy, UNI, 
and the related Federated Bodies, and the CEI are deputed to write 
standards. They are valid on the national territory and are written in the mother 
tongue of each country. 

Thanks to recognition agreements between ISO and CEN, it is possible to activate the 
Vienna Agreement which allows joint publication of a standard both at European and 
international level. In this case the abbreviation for Italy would be UNI EN 
ISO. Furthermore, UNI has decided to make the standards more usable by translating 
the main ones into Italian. At the same time, the Italian national standards have been 
translated into English and are presented for European and international works [13]. 

 

Figure 5:  Application diagram of the Standards in the world  

Source: https://www.ingenio-web.it/26765-standard-bim-il-mondo-dopo-la-iso-19650 
 

 

https://www.ingenio-web.it/26765-standard-bim-il-mondo-dopo-la-iso-19650
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1.4.   LEGAL CONTEXT 

1.4.1. UNI EN ISO 19650 

UNI EN ISO 19650-1: 2019 and UNI EN ISO 19650-2: 2019 are the transposition 
Italian ISO, the international standards to be referred to in the context of BIM design. 
ISO 19650 part-1: Concepts and Principles. The standard provides recommendations 
relating to a conceptual framework for information management, which includes 
exchange, registration, updating and organization for all actors. The standard applies 
to the entire life cycle of an immovable asset, including strategic planning, initial 
design, engineering, development, preparation of documentation for assignments and 
construction, daily operational operation, maintenance, refurbishment, repair, and end 
of life. The standard can be adapted to real estate assets or to orders of any size and 
complexity. ISO 19650 part-2: Delivery phase of the assets. The standard specifies the 
requirements for information management, in the form of a management process, in 
the context of the real estate delivery and information exchange phase, when using 
Building Information Modeling (BIM). The standard can be applied to all types of real 
estate and from all types and sizes of organizations, regardless of the procurement 
strategy chosen. These international standards apply jointly to UNI 11337 series, which 
is a complementary standard. 

1.4.2. Ministerial decree number 560/2016 

Legislative Decree 50 of 2016, implementation of directives 2014/23/EU, 2014/24/EU 
and 2014/25/EU, establishes the beginning of the processes for the development of new 
rules, times to innovate and integrate previous provisions in the field of digitization. 
Article 23 paragraph 13 reads: "The contracting authorities may request for the new 
works as well as for interventions of recovery, redevelopment or variants, primarily for 
complex jobs, the use of electronic methods and tools. Such tools use interoperable 
platforms by means of non-proprietary open formats, in order not to limit competition 
between technology suppliers and the involvement of specific planning among the 
designers. By decree of the Ministry of Infrastructure and transport, the methods and 
times for gradual introduction are defined of the mandatory nature of the 
aforementioned methods at the contracting authorities, granting administrations and 
economic operators ". 
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1.4.3. Ministerial decree number 560/2017 

The Italian Decree 560/2017, implementing article 23 paragraph 13 of the Decree 
Legislative 50/2016, also known as the 'BIM Decree' is the reference standard within 
the national territory that defines the modalities and timing of progressive introduction, 
as reported in Article 6, of the gradual mandatory nature of the methods and electronic 
building and infrastructure modeling tools, second the following timing: 

 For complex works relating to works with an equal or higher tender-based 
amount to 100 million euros, starting from 01.01.2019; 

 For complex works relating to works with an equal or higher tender-based 
amount to 50 million euros, starting from 01.01.2020; 

 For complex works relating to works with an equal or higher tender-based 
amount to 15 million euros, starting from 01.01.2021; 

 For works with a tender-based amount equal to or greater than the threshold 
referred to in article 35 of the code of public contracts, with effect from 
01.01.2022; 

 For works with a tender amount equal to or greater than 1 million euro, starting 
from 01.01.2023;  

 For works with a tender amount of less than 1 million euros, starting from 
01.01.2025; 

To the ministerial decree which represents a regulatory reference in the BIM field what 
defines the timing of introduction is flanked by the technical standard voluntary (non-
mandatory), which defines the guidelines to be followed in the adoption of this 
methodology. 
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1.4.4. The UNI 11337 Standard 

BIM is presently employed in Italy more than ever in a systematic fashion, thanks to 
the technical regulation (UNI11337), as opposed to before, when it was only used in 
projects built under international influences. The UNI 11337 standard is a ten-part 
document that deals with the management information processes of construction, 
specifically with models, documents, and information objects for products and 
processes, as well as the evolution and information development of models, documents, 
and objects, and information flows in digitized processes. The information is divided 
as follows: 

 PART 1: models, drawings and objects 

 PART 2: denomination and classification  

 PART 3: (information sheets) LOI and LOG 

 PART 4: LOD and objects 

 PART 5: management of models and documents 

 PART 6: example of informative specifications 

 PART 7: qualification figures 

 PART 8: PM / BIM-M  

 PART 9: building file  

 PART 10: administrative verification [14]. 

 

1.5.   LOD 

Within the framework of the methodological and conceptual approach that 
characterizes Building Information Modeling, particular importance is given to the 
theme of detail levels, the so-called LOD, the acronym for Level of Detail. The LODs 
have the task of precisely defining the level of depth of information of various kinds 
that are contained within the model. In this perspective, in particular, the Level of 
Detail represents a defined reference point that allows all the subjects involved in the 
project to specify and articulate the construction of a BIM model with a high degree of 
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clarity about its contents and maximum reliability. Information relating to it along with 
all the different phases in which the process of conception and realization of the work 
is articulated. The definition of the characteristics of every single Level of Detail 
concerning the type of element considered is a topic addressed by two important 
regulatory references, one of US origin one Italian [15]. 

American LOD System 

In the American context, the American Institute of Architects (AIA) has published a 
Level of Detail framework for the AIA Protocol G202-2013 Building Information 
Modeling, where the term LOD refers to the level of development necessary in relation 
to the contents of the model elements; the choice to use the definition “level of 

development” instead of “level of detail” is motivated by the fact that an element, 

although it may appear visually detailed, could in reality be generic. According to this 
document, the degree of development obtainable through the drafting of a building 
model defined through a BIM-type approach is divided into five levels [16]: 

 LOD 100: the element is represented in a generic way or with a symbol but 
does not meet the requirements for LOD 200; additional information about the 
model element can be derived from other elements; 

 LOD 200: the element is represented with generic quantity, size, shape, 
position and orientation; non-graphic information can also be linked to the 
element; 

 LOD 300/350: the element is represented with the correct size, position and 
orientation / the element is represented with the correct size, position and 
orientation and interfaces correctly with the other elements of the model; 

 LOD 400: the element is shown with correct size, position and orientation, 
interfaces correctly with the other elements of the model, and reports details 
relating to manufacturing, assembly and installation; 

 LOD 500: the element faithfully reflects reality, and is a representation verified 
on site in terms of size, shape, position, quantity and orientation. 
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Figure 6: LOD, AIA 
Source: https://www.01building.it/bim/lod-progettazione-bim/ 

Italian LOD System 

The Italian legislation that refers to Level of Detail is UNI 11337-4: 2017, which has 
among its assumptions the possibility of using any of the existing Level of Detail 
scales, without exclusions or priorities, according to the specific needs of the contract 
and provided that the specific references, the logic, the objectives and the structure are 
defined in advance for the purposes of maximum transparency for the interested 
parties. The UNI 11337-4: 2017, in particular, makes its own the fundamental 
terminological distinction between LOD, LOG and LOI; in this perspective, the LOD, 
level of development of digital objects, is composed of LOG, level of development of 
objects - geometric attributes, and of Level of Detail, level of development of objects 
- information attributes. 
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Figure 7: Data flow in the digital process through the LODs of the objects 
Source: https://www.ingenio-web.it/18667-sistema-dei-lod-italiano-uni-11337-4-

2017 

Unlike the 5 levels proposed by the AIA, UNI 11337 identifies the LODs 
through an alphabetical scale: 

 LOD A: the entities are represented graphically through a symbolic geometric 
system or a representation of genre taken as a reference without constraint of 
geometry. The quantitative and qualitative characteristics are indicative; 

 LOD B: the entities are virtualized graphically as a generic geometric system or 
a bounding geometry. The qualitative and quantitative characteristics are 
approximate; 

 LOD C: Entities are virtualized graphically as a defined geometric system. The 
qualitative and quantitative characteristics are defined generically in compliance 
with the limits of current legislation and the technical standards of reference and 
referable to a plurality of similar entities; 

 LOD D: the entities are virtualized graphically as a detailed geometric 
system. The qualitative and quantitative characteristics are specific to a defined 
plurality of similar products. The interface with other specific construction 
systems is defined, including the approximate dimensions for operation and 
maintenance; 
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 LOD E: the entities are graphically virtualized as a specific geometric 
system. The quantitative and qualitative characteristics are specific to a single 
production system linked to the defined product. The level of detail relating to 
manufacturing, assembly and installation is defined, including the specific 
dimensions for operation and maintenance; 

 LOD F: the objects express the virtualization verified on the site of the specific 
production system performed / built. The quantitative and qualitative 
characteristics are those specific to the single production system of the laid and 
installed product. The management, maintenance and / or repair and replacement 
interventions to be carried out throughout the life cycle of the work are defined 
for each individual product; 

 LOD G: objects express the updated virtualization of the actual state of an entity 
in a defined time. The management, maintenance and / or repair and replacement 
interventions to be carried out throughout the life cycle of the work are defined 
for each individual product [15]. 

 

 

Figure 8: UNI 1137-4, Example of LOD prefabricated walls 

Source: https://www.shelidon.it/?p=7828 
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Information models not only contain geometric data, but they are also a series of 
attributes (type of elements, materials, characteristics, performance, etc.), 
consequently, the model can be characterized by levels of graphic detail and 
information. Furthermore, add the inhomogeneity of the definition of the contents of 
the LODs, which varies by country and by the standard used. These considerations led 
to the introduction of a new definition "Level of Information Need" or LOIN in the 
ISO 19650 standard, using terminology that underlines and reiterates, on the one hand, 
the importance of information content whatever both their nature, the need, and the 
number and type of information on the other contained in the model are limited to those 
actually necessary.  

1.6.   Common Data Environment (CDE) 

The term Building Information Modeling (BIM) describes the process of creating and 
managing a digital model containing information of different types (structural, energy, 
geometric, plant engineering, etc.) of a building, whether it is in the design and 
construction phase or already existing. This process requires a specific tool for 
managing all information, which can be used by all the actors involved. It is precisely 
for this reason that the need arises to have a data-sharing environment. In many 
countries, this environment is defined as CDE (Common Data Environment) as defined 
by the British PAS 1192 standards and is adapted to allow the best use of the 
interoperability of BIM [17]. The Common Data Environment (CDE) is the single 
source of information for the project, used to collect, manage and disseminate 
documentation, the graphical model, and non-graphical data for the whole project team 
(i.e. all project information whether created in a BIM environment or a conventional 
data format). Creating this single source of information facilitates collaboration 
between project team members and helps avoid duplication and mistakes [18]. 
In Italy, the CDE takes the name of ACDat (Ambiente di Condivisione Dati) and is 
defined by Article 2 of Ministerial Decree 560/2017 and governed by UNI 11337. The 
art. 2 of the draft BIM decree states: “A digital environment for the organized collection 

and sharing of data relating to a work and structured in information relating to digital 
models and documents mainly attributable to them, based on an IT infrastructure whose 
sharing is governed by precise systems of security for access, traceability and historical 
succession of the changes made to the information content, conservation over time and 
relative accessibility of the information contained, the definition of responsibilities in 
the processing and protection of intellectual property” [19]. 
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In the British technical standards, the CDE is defined in an organic manner, while the 
Italian standard, UNI 11337, does not specify how the ACD will have to work and how 
it will have to be organized, but it only lists the aspects that must be met: 

 accessibility, according to pre-established rules, by all the actors involved in 
the process; 

 traceability and historical succession of the revisions made to the data 
contained; 

 support of a wide range of types and formats and their processing; 

 high query flows and ease of access, recovery and extrapolation of data (open 
data exchange protocols); 

 conservation and updating over time; 

 guarantee of confidentiality and security [17]. 

In this thesis it is used the Autodesk Docs platform for data sharing since this project 
has divided into different parts (Architecture, Structure, and MEP) and different 
students involved in which each of them had to develop his area. Autodesk Docs is 
a unified platform which is connecting the project teams and data in real-time, from 
design through construction, supporting informed decision-making and leading to 
more predictable and profitable outcomes. 

 

Project Information Model (PIM) 

It is an information model that provides all the data required to carry out the delivery 
phase of an asset. That is when an asset (building) is designed, constructed and 
commissioned. PIM resides in the project’s Common Data Environment and the 
collection of its information responds to the requirements set out by the Appointed 
Party in Exchange Information Requirements. It consists of all sorts of information 
containers: models, databases, spreadsheets and documentation. The amount of 
different data (information containers) in PIM augments gradually together with the 
development of the delivery process. In the brief phase, it may comprise only the 
scheme architectural model and some spreadsheets with requirements. Then further in 
the design or construction phase, it may contain a vast amount of information.  In 
practice, Project Information Model is all relevant data that sits in the Project’s 

Common Data Environment platform. PIM lasts as long as the project continues to 
develop. 
 
 
 

https://bimcorner.com/cde-within-iso-19650-a-process-or-a-solution/
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Asset Information Model (AIM) 

It is an information model that provides all the data required to carry out the operation 
phase of an asset (in contrast to PIM which provides data for the delivery phase). At 
the end of the project, some elements of the Project Information Model are transferred 
into the Asset Information Model and unnecessary data (residual project information) 
is archived. AIM comprises graphical models, non-graphical data, and all necessary 
maintenance, operation, and management documentation for objects in the model. 
Appointing parties, end-users, and facility managers create and use Asset Information 
Model, during the operational phase of the asset. The creation and structure of data in 
AIM should enable transfer to computer-aided facility management systems (CAFM), 
COBie, or another format for later management of the building. Requirements to the 
format of the deliverables should be agreed upon beforehand in Exchange Information 
Requirements. In practice, AIM comprises all files and data that the Delivery Team 
gives to the Appointing Party during the handover after completion of the project. 
Building Owner uses that information to set up a Facility Management system and 
operate the building [20]. 

 

Figure 9: Graphics bases on ISO 19650-1 presenting Information progress during 
different delivery phases. 

Source: https://bimcorner.com/iso-19650-terms-explained-in-this-simple-way/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://bimcorner.com/iso-19650-terms-explained-in-this-simple-way/
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1.7.   Roles and Responsibilities 

BIM technology applied to the entire life cycle of a building generates a significant 
production of data and information. In order to correctly and efficiently manage all the 
information involved, it is necessary to provide for an organizational structure where 
the roles and responsibilities of each actor in the process are well defined. It is therefore 
natural to expect that BIM in construction generates new professional figures with 
specific tasks and skills. The processes underlying BIM are positioned between the 
construction sector and the IT sector (it becomes necessary to manage information in 
an automated manner). The new figures responsible for the implementation, 
management and coordination of these processes are complex figures, who must 
possess distinctly multidisciplinary requirements. The whole of Europe is developing 
training courses and plans for these professionals. The same part 7 of UNI 11337 will 
define the professional figures related to BIM. 

 BIM SPECIALIST: The figure of the BIM Specialist is able to use the 
software for the realization of a BIM project, according to his disciplinary 
competence (architectural, structural, plant engineering, etc.). The BIM 
Specialist is able to understand and use the company's technical and operational 
documentation for the production of drawings and models. He carries out the 
activities of extracting data from models, artifacts and objects, processing 
graphic models and parametric objects, modifying the models and objects 
following the outcome of the multidisciplinary coordination procedures, 
modifying models and objects following design reviews. He can work under the 
supervision and coordination of the BIM Coordinator or the BIM Manager [21]. 

  BIM COORDINATOR: The BIM coordinator plays the role of coordinator of 
the BIM design team (including BIM Manager and BIM Specialist) involving 
them within the entire design process. The standard applies to the entire life cycle 
of an immovable asset, including strategic planning, initial design, engineering, 
development, preparation of documentation for assignments and construction, 
daily operational operation, maintenance, refurbishment, repair, and end of life. 
The BIM Coordinator is the one who guarantees the efficiency and compliance 
with standards and procedures defined at a managerial level by the BIM 
Manager. The BIM Coordinator will be able to deal with the information 
specifications and the information management plan will participate in the 
definition of the staff and the necessary equipment. It will take care of the 
quality, manage interference and conflicts, and the correctness of digital 
information flows. In addition, he will coordinate the work team by optimizing 
resources, coordinating the process of creation, management, verification, and 
management of digital models [22]. 
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 BIM MANAGER: The BIM Manager is the manager of digitized processes. He 
deals with the organization of digital processes, the supervision and general 
coordination of ongoing orders and the specialized human resources involved in 
the BIM process. The BIM Manager manages all the orders and interfaces 
mainly with two other management figures: the BIM Specialist and the BIM 
Coordinator; but he must have the right preparation to make the final decisions 
on his own. Although he is not always technically proficient in the software used 
by the group, he must nevertheless have a practical knowledge that allows him 
to be fully involved in the process of management and creation of standards and 
documentation. Some tasks of BIM Manager are: coordinate and supervise 
orders, prepare reports and collaborate in the audit activity, designate the BIM 
Coordinator, define the contractual aspects, draw up the information 
management offer and information specifications, drafting and updating 
organizational guidelines on information management, support the drafting of 
the information management plan [23]. 

 

 

 
Figure 10: Different figure involves in a BIM Process 

Source: https://bim.acca.it/bim-manager-bim-specialist-e-bim-coordinator-chi-
sono-cosa-fanno-e-come-si-diventa/ 
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1.8.   BIM for Management and Maintenance of Infrastructure 
 
Transportation infrastructure is a critical component to a nation’s economy, security, 

and wellbeing. Therefore, there is a great need for more efficient and cost-effective 
technologies and techniques to build, maintain, monitor, and repair these kinds of 
structures. Transportation infrastructure includes roads, railways, bridges, tunnels, and 
mass transit hubs (such as airports, ports, and harbors). BIM can be a suitable solution 
for extremely complex projects such as infrastructures where there in need to manage 
a huge amount of data with different formats. Managing data involves creating data 
(i.e., supplying data using data models); preserving data (i.e., storing, archiving, 
securing, and retrieving data); and, provisioning, exchanging, or sharing data for use 
during a variety of business operations. BIM helps to provide a visual data base that 
could be used through the whole lifecycle of infrastructure from design to construction 
to operation and maintenance (Figure 11). During the operation phase the benefits of 
using BIM include control of maintenance management process, integrated life cycle 
data, rapid and accurate information about update and change activities, and more 
effective Facility Management (FM) with easier information exchange. As a result, it 
reduces the time, risk, and cost of O&M management, which is the most expensive 
consumption of the entire infrastructure lifecycle, while contributing to more reliable, 
sustainable, and secure network performance and to better decision making [4], [24], 
[25], [26]. 
 

 

Figure 11: Lifecycle Phases 
Source: https://highways.dot.gov/research/research-programs/infrastructure/building-

information-modeling-bim-infrastructure-overview 
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2.1.  Metro Station 

The case study of this thesis is a typological metro station. as mentioned above, these 
types of infrastructure are of significant importance to the city in several ways. As with 
other similar case studies in this context, carried out by implementing the BIM 
methodology, this project includes several students each assigned to do part of a 
multidisciplinary model for this metro station. the task of the author is to develop the 
fire protecting system classified in the plumbing sub systems. As the whole project is 
still in progress, it is not possible to publish the project specifications. The three-
dimensional model below (Figure 12) shows the work done by the author for the fire 
protecting system of the metro station which will be explained in detail in the following 
chapters. 

 

Figure 12: Three-dimensional model of the Fire Protecting system 
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2.2.  MEP Engineering 

The acronym MEP (Mechanical, Electrical, Plumbing) refers to the BIM design of 
mechanical, electrical, and plumbing systems. MEP engineering is a term that relates 
to the management of a building's non-structural functions. It can consist of managing 
more than ten subsystems, including heating, ventilation, and air conditioning 
(HVAC), energy distribution, telecommunications, automation, fire protection, water 
supply, and drainage. Each system is a complex combination of different components, 
such as equipment, pipes, and cables. MEP engineering is concerned with the life cycle 
of any MEP subsystem, including the design, construction, operation, and maintenance 
(O&M) of the MEP system and its subsystems [27], [28]. 
MEP systems have become increasingly complicated over the time to fulfill advanced 
design and new facility needs, requiring greater space and coordination for installation. 
However, due to economical and energy efficiency reasons, the amount of space 
available in the structures is limited. As a result, MEP system coordination has become 
a particular challenge in large projects such as infrastructure [29]. BIM is an intelligent 
3D model-based process that enables MEP professionals to design, detail, and 
document building systems more efficiently. By using a BIM process, project teams 
can achieve more complete project data and feasibility while reducing risk and 
improving results [30]. The possibility of having an MEP model with an architectural 
model already in the design phase allows creating and modifying the Mechanical 
Components (pipes, ducts) based on the architectural or structural model [31]. Another 
advantage of using Revit MEP is to prevent location conflict which is a common error 
in mechanical design by helping to understand the space occupied by mechanical 
equipment. Furthermore, by using Autodesk Navisworks it is possible to highlight all 
clashes for instance within MEP systems against other MEP systems or MEP against 
the structure to make sure there is harmony between the Architectural, Structural, and 
MEP design. Conflicts eliminated at an early stage will surely have a positive outcome 
on the project [32]. 
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2.3.  Methodological Approach 
 
 
 

 
Figure 13: Project Workflow 
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3.1.  Data collection 

The first step is analyzing the input data shared in Autodesk Docs. The project team 
may transfer and share information and data within a single solution using Autodesk 
Docs, which supports the whole project workflow. Disciplines are separated into 
different folders. 

 

Figure 14: Autodesk Docs platform 

All data was saved with particular codifications according to a text file that established 
indications for the template and file naming and was accessible to all members of the 
team, enabling better interoperability. Table 1 shows how the coding related to this 
thesis has been renamed: 
 

TOM_LOM_00_ZZ_M3_PFP_0001_P00 
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Code File type 

TOM Project acronym 
LOM Responsible organization acronym 
00 Indication of the zones and volume to 

which it refers the file 
All zones 

ZZ Indicates levels and positions to 
which the file refers 

Multiple 
levels 

P 
FP 
M 
A 
S 
F 

Indicates the discipline and any sub-
discipline the file belongs to 

Plumbing 
Fire 
Protection 
Mechanical 
Architecture 
Structure 
Coordination 
 

0001 Indicates the first file in the series 
P00 Indications that the file has not yet undergone 

validation 

Table 1: File codification 

 

Since Fire Protection was not presented in the table relating to the "discipline" it is 
considered necessary to create a sub-discipline of “Plumbing (P)”, named “Fire 

protection (FP)” (See Table 1). 

3.2.  Software 

The popularity of BIM has increased in recent years and so many companies have 
adopted BIM for their projects around the world. The graphic interface is divided into 
tabs and enables for multiple views to be viewed at the same time, with a dynamic 
relationship between them. so if you modify or change something in a view, it will be 
update automatically in other views. In this case study, Autodesk Revit 2020 is used. 
Autodesk Revit is a software created for BIM with the capabilities for architectural, 
MEP (mechanical, electrical, plumbing) and structural disciplines of the AEC sector. 
Revit gives the user the possibility of interacting with different file formats like DWG, 
DXF, IFC, DWS, gbXML.  
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 Revit Architecture: allows you to create a model starting with the initial design 
and ending with construction documents, as well as optimizing building 
performance with centralized access to performance data. It allows you to add 
architectural features to your model, make accurate renderings.  

 Revit structure: It helps to simplify projects, from design idea to manufacturing, 
by linking the structural design to the detailed model, it is possible to improve 
the precision and constructability of the installation. It is possible to make a 
comparison with the other components of the building and analyze their 
structural and safety compliance with the current rules. 

 Revit MEP: It allows mechanical, electrical, and plumbing (MEP) engineers, 
designers, and contractors in modeling to a high level of detail and coordinating 
with construction project stakeholders. As a result, it is able to design complex 
duct and piping systems, model and document electrical systems, design sanitary 
systems, and test for interference. 

The parametric digital model is made in Revit 2020, although the 2021 version was 
already available on the market since the Architectural and structural parts already have 
been done in the 2020 version and it could be possible to update them to 2021, but in 
this way, they were no more convertible to 2020, so for the better interoperability 
between data and project teams, it was decided to continue in 2020 version also for the 
MEP part. 

3.3.   Setting Phases - Template 

The Template is the Revit work environment, which is designed to serve as a binder 
containing a set of design settings, families, annotations, and labels to fully explain the 
project [32]. A project template provides a starting point for a new project, including 
view templates, loaded families, defined settings (such as units, fill patterns, line styles, 
line weights, view scales, and more), and geometry, if desired [33]. It is possible to 
choose a default template or define a custom template. The project template uses the 
file extension RTE while the template family use the file extension RFT.  

3.3.1. User Interface and Display 

Setting the rules for the Project Browser in Autodesk Revit allows you to organize the 
user interface. This method enables the establishment of an effective object 
visualization hierarchy. 2D, 3D Views, Schedules, and other elements make up a Revit 
model. By clicking on a view name, one can navigate and switch between multiple 
views. Each view has its own set of characteristics, such as scale, discipline, and so on. 
These views can be duplicated, with each duplicated view having its own set of 
characteristics. As a result, rules for viewing and querying views must be defined. This 
structure enables a more efficient viewing of data (Figure 15). 
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Figure 15: Project Browser, Revit 
 

3.3.2. Revit links 

The structural model of the project which was uploaded into a folder containing the 
Revit files in the common data environment (CDE) which in our case was Autodesk 
Docs has been linked to the Revit project. From the menu insert > Link Revit, select 
the structural template (Figure16). By selecting the Revit link a window appears in 
which we can search the file name. Then we have to position the file into our project 
choosing Auto – by shared coordinates (Figure17). If we click insert > manage links 
or manage > manage links, it will open a tab that shows all the files linked to the project 
and change their properties (Figure 18). For instance, we can define the reference type 
as overlay or attachment. If the model that is linked to the project contains other linked 
models the links become nested. By choosing overlay the nested models can be not 
loaded into the host model and therefore they are not displayed but if we choose 
attachment instead the nested models will be loaded in the host model and we can see 
them in the project.  

 

Figure 16: Link Revit, Revit 
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Figure 17: Import/Link RVT, Revit dialog 
 

 

 

Figure 18: Manage Links, Revit 
 

3.3.3. Shared Coordinates 

When you get coordinates from a linked model or file, the linked model's coordinates 
become the host model's shared coordinate system. True North is also acquired by the 
host model from the linked model. The shared coordinates origin of the linked model 
becomes the shared coordinates origin of the host model. The internal coordinates of 
the host model remain unchanged. To acquire coordinates going to menu > manage > 
coordinate > acquired coordinates (See figure 19). 
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Figure19: Shared Coordinates, Revit 

3.3.4. Levels  

Levels, as well as project files, also have a standard encoding defined in the file present 
on Autodesk Docs. The levels are coded with respect to the GL (Ground Level - ground 
floor), AGL (Above Ground Level - above ground), and UGL (Under Ground Level - 
underground). 

3.3.5. Work-set 

When working on a team project, you must choose an active work-set. The active work-
set contains each new model element you add to the project. The work-set for the cur-
rent view contains view-specific components such as annotations and dimensions. It is 
possible to create work-sets based on functional areas, such as for architecture and 
structural engineering: interior, exterior, and the site or for systems: HVAC, electrical, 
or plumbing. When working with ownership of items in a work-set, the difference be-
tween making a work-set editable and borrowing from a work-set is critical. You take 
complete ownership of all objects in a work-set when you make it editable in Revit. At 
any given moment, only one user can edit each work-set. All team members have ac-
cess to other team members' work-sets, although they are not always able to make 
modifications to them. This stipulation eliminates the possibility of internal contro-
versy in the project. You can borrow an element from a work-set that you do not own 
[34]. To create a work-set in Revit click on collaborate > work-set, by selecting new 
you can create all the desired work-sets. In the collaborate section, you can also view 
the current one and modify it if it is necessary (Figure 20). 
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Figure 20: Work-set, Revit 

 

 

3.3.6. Revit Families 

Revit Families are a group of elements with the same set of properties, known as pa-
rameters, and their associated geographic representation. In simpler terms, Family is a 
remarkable feature of Revit BIM that provides libraries of pre-built objects that can be 
modified to fit the needs of any project. It is an important aspect of the software because 
it generates all of the parts that are used in the project or created to meet the project's 
requirements. Walls, doors, windows, beams, columns, and annotations and tags are 
examples of both structural and non-structural features. You may also obtain control 
over a group of elements with the same behavior and features by using families, making 
it easier to manage the overall project. There are three types of Revit Families: 

 SYSTEM FAMILIES: System families are pre-defined families that contain el-
ements used to create basic components needed for assembly on a construction 
site. Their parametric and graphical representations already exist; they cannot be 
loaded into the system, created, deleted, or saved. For example, walls, floors, 
roofs, and so on. These families are used to create 3D models where only show 
the placements of basic components needed. 

 LOADABLE FAMILIES: Loadable families, also known as component families 
are user-defined and are built in a family template using an editing mode called, 
Family Editor. They can be created and then imported into Revit projects. Their 
parameters and graphical representation can be defined from scratch. These are 
created in external RFA files and then imported and loaded into the project, un-
like system families. They are the most commonly used Revit families because 
of their highly configurable nature, which allows you to create, change, delete, 
and save from the project. Using varied materials and sizes, a variety of types 
can be created within this one family. A lot of types can be created within this 
one family using various materials and sizes. There are different types of 
loadable families:  
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a) Parametric Families This form of family is mostly used to control the funda-
mental properties of any component, such as its height, breadth, and length. 
Frameworks, materials, and category assignments are all basic parametric as-
pects. 

b) Nested families: Nested families are families that exist within other families, 
as the name implies. The fundamental benefit of these families is that they may 
be mirrored, flipped, and rotated into the desired configuration while maintain-
ing the same relationship with one another. When there are repeating elements, 
such as the louvered window, these families are typically used. 

c) Hosted families: These are the kinds of families that need a host to be included 
in the model; they can't stand on their own. If a family is designed to be wall-
hosted, for example, it can only be installed if a wall is present in the host 
model. 

Revit has default families that can be inserted and, if necessary, modified. To insert 
them click on Insert > Load Family (Figure 21).  

 

Figure 21: Load Family, Revit 
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If the default families do not meet the requirements, there is the possibility to create 
of the families that can be loaded by clicking on File> New> Family (Figure 22). 

 

Figure 22: New Family – Select Template file, Revit 

 

 

 In place families: Custom elements that are specific to a project can be created 
using in-place families. These are project-specific; thus they don't allow you to 
create different types like loadable families do. These families are similar to sys-
tem families, but they cannot be generated or used as standalone families; in-
stead, they can be developed, edited, or inserted within a model. There are no 
distinct RFA files for them to be created in. These families are particularly val-
uable in complex construction plans that require components that are specially 
designed. Custom gutters, special trim, and built-in furniture are examples of 
such features. Thus, in-place families in Revit Family Creation are particularly 
used when there is a need to represent a unique element to the project. 

There are other types of families but these are the most known. Revit families have 
different purposes to meet different needs which makes Revit user-friendly [35]. 

 

 

https://www.revitbimservices.com/#services
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For the template file naming, there is codification rules also for the families, the indi-
cations for family encoding present below (see Table 2): 

TOM_LOM_PFP_Pipe Fittings_ (Elbow Fitting) 

 
Code  type 

TOM Project acronym 
LOM Responsible organization acronym 
P 
FP 

Indicates the discipline and any 
sub-discipline the file belongs to 

Plumbing 
Fire Protection 

Elbow Revit category Pipe Fittings 
(…) Object type Elbow Fitting 

Table 2: Family Codification 

3.3.7. Parameters 

The information has great importance in the Revit as explained before in the part ded-
icated to LODs. Level Of Information is known as LOI and it is used to indicate non-
geometric information of a family. Every family created for the project has LOD card. 
A family with a high level of information may include information like datasheets, 
manufacture specifications, and maintenance instructions. The information can be 
added to the project using parameters. In Revit, it is possible to create parameters for 
any elements category or components or even for a project. The created parameters are 
visible in the properties dialog of the type of property palette depending on whether 
they are a type or instance parameters., different types of parameters are listed below: 

 Global Parameters: Global parameters are unique to a single project file and are 
not associated with any categories. Global parameters can be simple values, val-
ues derived from equations, or values extracted from the model by combining 
them with other global parameters. To drive and report values, use global pa-
rameters. 

 Shared Parameters: Shared parameters are parameter definitions that can be used 
in multiple families or projects. You can use a shared parameter definition as a 
family or project parameter after adding it to the family or project. The definition 
of a shared parameter is protected from change because it is stored in a separate 
file (not in the project or family). As a result, shared parameters can be tagged 
and scheduled. 
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 Family Parameters: Family parameters control the family's variable values, such 
as dimensions or materials. They are unique to the family. A family parameter 
can also be used to control a nested family parameter by associating the host 
family parameter with the nested family parameter. For creating the Family pa-
rameter, you need to first you have to open the family to which you want to 
associate the parameter, click on the Family Type icon and create the new pa-
rameter (Figure 23 and 24). 

 Project Parameters: Project parameters are specific to a single project file. They 
are added to elements by assigning them to multiple categories of elements, 
sheets, or views. Project parameters contain information that cannot be shared 
with other projects. In a project, project parameters are used for scheduling, sort-
ing, and filtering [36]. For creating the project parameter Clicking on Manage > 
Project Parameters > Add and it will open the window (Figure 25). To select the 
newly created shared parameter, just click on Shared parameter > Select, and 
then select the parameter. Depending on the parameter, it is possible to choose 
whether to assign it to "Type" or "Instance" and define the parameter data, such 
as name, discipline, parameter type, grouping. Also, you need to select the cate-
gories of items in which it will come inserted this parameter. 

 
Figure 23: Family Types, Revit 

 
 



44 | P a g e  
 

By clicking on New Parameter it will open a window where you can define a new 
Parameter Property. 

 

Figure 24: Parameter Properties, Revit 

 

Figure 25: Project Parameters, Parameter Properties, Revit 
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3.4. Modeling  

The first step is to create the views plan of the project in Revit by clicking on view > 
plan views > floor plan, it appears a window that allows creating a view of the plan 
for the desired level. Then we inert the associated DWG or PDF file of the associated 
plan. In our case since we did not have accessibility to DWG files of the project, we 
used PDF documents. For inserting the PDF File clicking on Insert > PDF and select 
the desired file (Figure 26). 

 

Figure 26: Import PDF, Revit 

 

3.4.1. Fire Protection System 

The Fire Protection System is classified in the plumbing subsystems and this thesis is 
a wet Fire-Extinguishing system which is consists of a distribution network of pipes to 
allow the water reach to sprinklers. These pipes are made from steel because they 
should make out of fire-resistant material. They are always full of pressurized water. 
In Revit, Pipes are part of the System Families type. The model was created by using 
the default pipes family found on the Revit. The diameter of pipes is changed and they 
are varied from DN20 to DN200. To draw a pipe clicking on Systems > Pipe > Pipe 
types (Figure 27 and 28).  

 

Figure 27: System Families – Pipe, Revit 
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Figure 28: Pipe Properties Window, Revit 

 

3.4.2. Routing Preferences 

After selecting the pipe, we need to set the routing preferences. In Routing Preferences, 
it is possible to select the fittings that will be placed during the use of this type of 
pipe. Multiple fittings can be added for each part type section (Elbow, Junction, Cross, 
Transition, Union, Cap) thus for the pipe segments, Multiple pipe segments may be 
added to a routing preference. In order to do that just click on the plus sign. If more 
than one part for a fitting satisfies the criteria during layout, the first part listed is used. 
You can move a row up or down to change the priority for a part. When specifying the 
size range for a part, none means the part will never be used and All means the part 
will always be used. Setting the size range to None is useful when modifying fittings 
after layout. A fitting whose size is set to None will display in the Type Selector when 
the Constrain to routing preferences option is enabled. It is possible to use default fam-
ilies of fittings or create a new fitting family. If none of the default fittings doesn’t meet 

our needs, we can create a customized fitting. For setting the routing preferences click-
ing on properties > Edit Type > Routing Preferences (Figure 29).  
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Figure 29: Routing Preferences, Revit 

The fitting that is used during this project for the pipe is partly default families and 
partly instead created according to since there were no default fittings that corre-
sponded to required features. Below there is the list of pipe fittings used (Figure 30): 

 

 

Figure 30: Pipe Fitting Families, Revit 



48 | P a g e  
 

Since the pipes in the plan didn’t follow a straight route there are inclinations in some 
parts, it was necessary to create an Elbow fitting with a specific angle based on the pipe 
inclination degree to obtain the joints between the pipes. In order to do this a Revit 
“Generic model” family template is used. It is possible to create different types for the 
family by changing the parameters like angle or size since it is created as a parametric 
element (Figure 31). 

  
Figure 31: Elbow Fitting Family, Revit 

Additional settings can be added to the pipe in the routing preferences dialog by click-
ing on segment and size. In the window of mechanical settings, it is possible to set 
other settings for the pipe, for instance, angles, conversion, segments and sizes, fluids, 
etc. The size range and material of the pipe and other properties like roughness also 
can be set here (Figure 32).  

 
Figure 32: Mechanical Settings, Revit 
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While drawing the pipe system the best practice is to have checked the “Show Discon-

nects” option, since it helps to realize if there is any problem in the piping system. 
These problems can occur due to a disconnection or inconsistency between systems 
when trying to connect to elements from two different classification systems. For doing 
that click on Analyze > Show Disconnects and choose Pipes (Figure 33and 34). 

 

Figure 33: Analyze – Show disconnect, Revit 

 

Figure 34: Show Disconnects Option – Pipe, Revit 
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3.4.3. Materials and colors 

The choice of material and color was made for the visual representation of the pipes. It 
is possible to assign a color to material by clicking on Manage > Materials (Figure 35).  

 

Figure 35: Material Browser, Revit 

3.4.4. Pipe Accessories 

Pipe accessories includes families of calibration, regulation and butterfly valves. For 
this part it is used default families in some parts since they were corresponded to the 
needs of the project and for some parts they are obtained by modifying a default Revit 
family. Pipe accessories are listed below: (Figure 36 and 37) 

 

Figure 36: Project Browser, Revit 
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Figure 37: Pipe Accessories, Revit 
 

3.4.5. Sprinklers 

Fire Protection Systems save lives in the event of a fire. A well-maintained fire 
sprinkler system, in conjunction with other fire protection measures, can help suppress 
smoke and flames and lessen the spread of the fire, reducing damages and giving 
everyone time to exit the building while fire services arrive.  At the moment of fire, the 
sprinkler nozzle causes outflow of water and results in a quick intervention of fire. The 
sprinklers have different types. In this project it is used a default family of Revit for 
the sprinklers. 

 

Figure 38: Sprinklers, Revit 
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3.4.6. Result 

In conclusion at the end of the modeling phase, a three-dimensional information model 
of the Fire Protection System was obtained, with the data required for the exportation 
process as we will be seen. 

 

Figure 39: Top View of the Model, Revit 

 

Figure 40: Front View of the Model, Revit 
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Figure 41: isometric View of the Model, Revit 

 

3.5.  Federated Model 

BIM Model Federation is the most popular method of collaboration and the simplest 
to implement of the workflows. A BIM federated model is used in the design of 
coordination, clash detection and avoidance, approval processes, design development, 
estimating, and other processes [32]. Federated BIM models combine components 
from various disciplines onto a single data environment (CDE). This inter-disciplinary 
collaboration improves coordination, prevents information loss, reduces rework, and 
enables better project management. As per NBS, a Federated Model is “a combined 

Building Information Model that has been compiled by amalgamating several different 
models into one, or importing one model into another.” In a federated model, distinct 
individual models originating from multiple construction disciplines – architects, 
structural engineers, MEP engineers, contractors, sub-contractors, and suppliers can be 
seen on one tool. Even when individual multidisciplinary models are linked together 
in a federated model, they retain authorship, remain distinct, and cannot be modified 
by others without permission. Federated models lead to better design decisions by 
highlighting missing information, discrepancies, and insufficient resource allocation 
during the early stages of construction. The integration of multidisciplinary models into 
a single model improves seamless coordination, fosters a better understanding of 
design intent across disciplines, and increases transparency among stakeholders 
throughout the project life cycle [37]. For this project, a federated model was created 
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to host all the models developed about the project. Structural and HVAC models 
extracted from the Common Data Environment are also included. The inclusion is 
made by links. 

 

Figure 42: Federated Model – Section T2-T2, Revit  

 
Figure 43: Section T2-T2 from the plan, Revit 
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Figure 44: Federated Model - Isometric View, Revit 
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4.1. Interference Check  

Engineering design is a dynamic field that needs effective coordination among various 
stakeholders in order to achieve the desired results. Architects, structural engineers, 
MEP engineers (HVAC, electrical, and plumbing), environmental engineers, and other 
professionals work individually to create design models. The clash detection process 
identifies where the independent models clash with each other- finding where elements 
from one model overlap the elements of models from other architect-engineering 
design disciplines. Clash detection ensures that all aspects work together and that 
nothing is incompatible. Without clash detection at the design stage with the help of 
integrated models, completing projects in this era is next to impossible. Interference 
and clashes can cause losses, delays, and other issues during the construction stage, 
and can even result in a total design failure in terms of compliance. With clash 
detection, mistakes that would normally be discovered on-site (with high cost and 
schedule implications if corrected at that stage) can be seen in the earliest stages of 
design, resulting in a faster project and a lower budget [38]. 

4.1.1. Data Collection 

Advanced clash detection and design review software, such as Navisworks, makes it 
easier for architects and building designers to divide larger models into subsets for 
focused clash detection. Clash report is always generated between two design models 
using Autodesk’s Navisworks. Once three-dimensional models have been obtained, 
each model can be exported from Revit in NWC format to open in the Navisworks. For 
doing this click on File > Export > NWC and set correct parameters to obtain the model 
in NWC (Figures 45-47).  

 

Figure 45: Export NWC Format, Revit 

https://www.autodesk.com/products/navisworks/overview
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Figure 46: Export NWC Format, Revit 

 

Figure 47: Navisworks Option Editor - Export NWC, Revit 

 



59 | P a g e  
 

4.1.2.  Software 

For static and dynamic interference checking, the Autodesk Navisworks Manage 
software, in the 2020 version. This program allows the identification and management 
of problems caused by conflicts and interference before the construction of the work.  

4.1.3. Import of Disciplinary Models 

To do the clash detection in Navisworks we need to import the disciplinary models 
which we converted before from Revit to NWC format by clicking on Start > Append 
and then selecting the desired file (Figure 48). 

 

 

 

Figure 48: Append NWC, Navisworks 
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4.1.4. Check for Duplicates - Level 1 Validation 

The first step to controlling the validation of the models is to check for duplicates. This 
option allows the clash test to detect duplicate geometry. This type of clash test is useful 
to check the model against itself to ensure the same part has not been drawn, or 
referenced twice, for example. To do this, you must then select Add test and choose 
the "duplicates" type from the drop-down menu (Figure 49-51). 

 

Figure 49: Add Duplicate Test, Navisworks 

 

 

Figure 50: Duplicate Check Setting, Navisworks 
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Figure 51: Duplicate Check Results, Navisworks 

4.1.5. Hard Clash detection - level 2 validation 

The next level of validation of the model is at the coordination level. This type of clash 
test allows detecting actual intersections between geometry. It is necessary to follow 
the following steps: Rename the test (for example “PFP vs M” corresponds to the 
control of the interference between the pipe model and the ventilation one); select the 
two files you want to compare. Remember that it is also possible to check for 
interference between two elements/objects; in this case, it is necessary to select the two 
or more interested parties; In this section, we just need to modify the settings to change 
the type from duplicate to hard and then run the test (Figure 52). 

 

Figure 52: Hard clash detection Check Setting, Navisworks 
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As can be seen from the results these interferences turn out to be all of the Hard type 
(Figure 53 and 54). Interferences occur when two objects come into physical contact 
with each other. These types of conflicts must be resolved quickly by moving or 
replacing the elements that cause the conflict. 

 

Figure 53: Clash Detection Results, clash1 – PFP vs M, Navisworks 

 

Figure 54: Clash Detection Results, clash7 – PFP vs M, Navisworks 
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Once the test has been completed and the results have been obtained, it is possible to 
download the report of the clash detection in HTML format by clicking on the write 
report. (see Figure 55). HTML will create an HTML file containing all the clashes and 
a jpeg of their viewpoints alongside their details. On choosing this option, you will need 
to select or create a folder for the files and enter a name for the HTML file. By choosing 
the current test as the report type it creates a single report for the current test only  

 

Figure 55: Interference Report, Navisworks 

It is possible to enter comments relating to the interferences found and also BIM 
Coordinator can choose a person to assign the responsibility for the selected clashes 
(Figure 56 and 57). we can group the clashes for the better organization but they will 
be listed as a single clash in summaries and reports.  

 

Figure 56: Add Comments, Navisworks 
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Figure 57: Comment Example – PFP vs Ventilation, Navisworks 

4.1.6. Clashes statuses 

An icon is displayed to the left of each clash name. It visually identifies a clash status 
as follows (Figure 58): 

 New: A clash found for the first time in the current run of the test. 

 Active: A clash was discovered in a previous run of the test and was not resolved. 
Clashes in this state are pending. 

 Reviewed: A clash previously found and marked by someone as reviewed. 

 Approved: A clash previously found and approved by someone.  

 Resolved: A clash found in a previous run of the test and not in the current run 
of the test as a result of changes to the design file so the status will automatically 
change to resolved. 

 

Figure 58: Clashes Status, Navisworks 
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4.1.7. Result  

The model is modified on the basis of the clashes that found in the clash detection 
test.as a result there is no more clashes are found in the new run of the test (Figure 
59): 

 

Figure 59: Clash Detection Result Test, Navisworks 
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4.2. EXPORTING PROCESS 

The next step is exporting the Revit model in to the JSON format using Dynamo. 

4.2.1. DYNAMO  

From its origins as an add-on for Building Information Modeling in Revit, Dynamo 
has matured to become many things. Above all, it is a platform that allows designers 
to explore with visual programming, solve problems, and create tools. Dynamo is 
available for free download and aims to be accessible to both non-programmers and 
programmers. It allows users to visually script behavior, define custom logic, and 
script using various textual programming languages via visually script code blocks.  
This allows the users to manipulate elements, data, and geometry in Revit by cou-
pling script nodes. Nodes are the objects which are connected to form a graph or 
(visual program). The language used to write the codes is in Python and each node 
performs simple or complex operations to complete a calculated task in Revit. Most 
Nodes in Dynamo are composed of five parts. While there are exceptions, such as 
Input Nodes, the anatomy of each Node can be described as follows: 

1. Name of the node; 
2. The main body of the Node. Right-clicking here presents options at the level of 

the whole node; 
3. The in and out ports. The receptors for Wires that supply the input data to the 

Node as well as the results of the Node's action; 
4. Lacing Icon. Indicates the Lacing option specified for matching list inputs; 
5. Default Value. Right-click on an input Port, some Nodes have default values that 

can be used or not used. 

 

Figure 60: Anatomy of a Node, Dynamo 
Source: https://primer.dynamobim.org/en/03_Anatomy-of-a-Dynamo-Definition/3-

1_dynamo_nodes.html 
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The Inputs and Outputs for Nodes are called Ports and act as the receptors for Wires. 
Data comes into the Node through Ports on the left and flows out of the Node after 
it has executed its operation on the right. Ports expect to receive data of a certain 
type. Data is the stuff of Dynamo. It travels through Wires, supplying inputs for 
Nodes where it gets processed into a new form of output data. Data is a set of values 
of qualitative or quantitative variables. The data is needed to add to the input Ports 
of Dynamo's Nodes – It is possible having data without actions but we need data to 
process the actions that our Nodes represent. When we've added a Node to the 
Workspace, if it doesn't have any inputs supplied, the result will be a function, not 
the result of the action itself [39]. 

4.2.2. Dynamo for Exporting Data 

The first step for extracting information from the Revit model through Dynamo is by 
inserting a node which is named ‘Categories’. Then we have to select the desired cat-
egory. To do this clicking on Revit > Selection > Categories. After selecting the desired 
category, we have to insert another node ‘All Elements of Category’ to select all ele-
ments and connect these nodes with a wire. Wires connect the output Port from one 
Node to the input Port of another Node. This directionality establishes the Flow of 
Data in the Visual Program [39]. Then it is possible to create a group by selecting 
both nodes and Right Click > Create Group (Figure 61) and name it ‘List of all Ele-
ments for a Specific Category’.  
 

 

Figure 61: Selecting all Elements of the Revit Pipe Category, Dynamo 

The next step is to create a list of parameters that we need to extract from elements by 
inserting a code block; Right Click > Code Block. There are two types of parameters 
as we mentioned previously. Instance parameters and type parameters. In this thesis, 
all the parameters extracted were instance parameters. The instance parameters in this 
workflow are divided into two groups of getting Parameters and Set Parameters (Figure 
62).  
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Figure 62: Pipe Category Parameters, Dynamo 

Get parameters are the parameters that already exist in the Revit model. Set parameters 
are the parameters that don’t exist and we need to create them for the element. For 

creating a new project parameter as mentioned in the previous chapter, go to the Revit 
> Manage > Project Parameters and create Element Id, Element Level, and, Location 
(Figure 63 and 64).  
 

 

Figure 63: Creating New Project Parameters, Revit 
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For the location, the plan is divided into three different zones of A, B, and C, and the 
parameter is assigned to each element depending on where it is located in the plan. 

 

Figure 64: Element Properties – Data, Revit 

Then we insert the Element Id and Element Name node and for the rest of the 
parameters which they don't have a node with their name in dynamo we have to obtain 
them by inserting ‘Element.GetParameterValueByName’.  after that, we can create a 

group for each parameter and subsequently, selecting those parameters from the code 
blocks and connect them to the parameter name input and from the other side connect 
the output of all elements of the category to the element input of each parameter group. 
For the set parameters, we have to insert another node 
‘Element.SetParameterparameterByName’, and connect the output of each set 

parameter group which is a string to the input value of these nodes (Figure 65-67). 

 

Figure 65: Parameter Groups, Dynamo 
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Figure 66: Parameter Groups, Dynamo 

 

Figure 67: Dynamo Workflow, Dynamo 
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At this step, we have all the information that we need to extract from the model and we 
have to create a list from them by inserting the node ‘List Create’ and connecting the 
output of each parameter to this list. 

4.3. JSON Format 

The last step is to export the data in JSON format. JSON stands for JavaScript Object 
Notation is a lightweight popular format for storing and transporting data. As the name 
suggests, JSON is derived from JavaScript but later embraced by other programming 
languages. JSON is "self-describing" and easy to understand and it is often used when 
data is sent from a server to a web page. JSON file ends with .Json extension but it is 
not compulsory to store the JSON data in a file. It is faster, needs very less formatting, 
and has a higher parsing efficiency than XML and due to the inadequacies of XML, 
JSON has been widely used in Web applications. XML and JSON are two different 
data serialization formats used in web applications. JSON data is stored as key-value 
pairs similar to JavaScript object properties, separated by commas, curly braces, and 
square brackets. A key-value pair consists of a key also called name (in double quotes), 
followed by a colon (:), followed by the value (in double-quotes) [40], [41].  For 
exporting the report to JSON format we need to download packages for JSON by 
clicking on Packages > Search for a Package and then write the name of desired 
package (Figure 68 and 69). 

 
Figure 68: Dynamo Packages, Dynamo 

 
Figure 69: Dynamo online search package for JSON, Dynamo 
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In this project, the JsonData package is used for exporting to JSON. After downloading 
the package clicking on JsonData > JsonObject and select the node 
‘By.KeysandValues’ (Figure 70). 

 
Figure 70: JSON Package, Dynamo 

At this point, two lists of data need to be created for the parameters name and their 
related value for the Keys and Values input. The values output must be connected to 
the values input using the ‘List.Transpose’ node (Figure 71). 

 

Figure 71: Dynamo workflow – Exporting to JSON Format, Dynamo 
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For converting the JSON object to the readable format we have to use another node 
‘WritetoJsonFile’ by clicking on JsonData > Utilities > Write > ToJsonFile (Figure 
72). 

 

Figure 72: Write to JSON file, Dynamo 

the last step of exporting the data is to define the file path by adding the node of File 
Path and clicking on brows (Figure 73). We have to save the name of the file with the 
.Jason extension. Then we can click the Run and export the JSON format (Figure 74). 

 

Figure 73: JSON File path, Dynamo 
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Figure 74: Dynamo Workflow Run, Dynamo 
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4.3.1. Result 

At the end of the exporting process, a file with the JSON format is obtained. This file 
includes the data needs for all the elements of selected category which in this case 
was the pipe and the same process can be done for all the categories including in the 
Revit model (Figure 75). 

 

Figure 75: JSON File 
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5. Conclusion  
It is evident that as the construction industry expands and becomes more complex, new 
needs arise. On the other hand, technology is advancing at an incredible rate every day. 
Therefore, the construction industry must adopt new technologies to meet all the pro-
ject needs. Since it emerged, BIM has revolutionized the construction industry and 
helped to optimize projects in different aspects.  It reduces the costs and while speeding 
up the project increases its accuracy. Another benefit of using BIM is that the data will 
be managed properly and can be used for the maintenance phase of the project. These 
benefits make BIM an essential tool in complex projects such as infrastructure where 
maintenance and management can be a challenge due to the information accessibility 
issue which is a difficult and time-consuming process. This thesis aimed to take a step 
forward in improving the maintenance issue by exporting data from the BIM model in 
a format that can be used for facility management. The process involved obtaining a 
digital model of a fire protection system and verifying it in terms of conflicts with 
another MEP model of the project (HVAC System) and modifying the model based on 
the clashes. After that, the data is exported from the Revit model to JSON format using 
Dynamo. The JSON format can be used as a common language to make the communi-
cation between BIM and BMS through a platform. This creates a relationship between 
the physical and digital assets. If some problem or failure happens, the data will transfer 
from the sensors to this platform and from then will send back to the BIM model. In 
this case, the digital information model can be updated based on the data from the 
monitoring system. It can be possible after that to open a ticket for maintenance inter-
ventions.  

all being said, exporting data from Revit to JSON is one of the first steps, following 
this idea as part of the future developments, there is a need to create a facility manage-
ment platform for integrating BIM and BMS using JSON format for exchanging the 
data.  
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